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EDconnect 6.X 

Error Code List 

Introduction 

If a transmission fails, EDconnect 6.X will ask you to 
review the Activity Log for details. In most cases, the error 
message in the Activity Log will consist of an error 
number followed by “See EDconnect 6.X Error Code List 
at http://www.fsadownload.ed.gov/softedconnect.htm.” 

The first section of the EDconnect 6.X Error Code List 
provides descriptions of Numerical Errors  you may 
receive and their possible resolutions. Some of the 
resolutions may require the help of your technical support 
staff or network administrators. 

Under certain circumstances, you may receive non-
numerical error messages or other program errors. These 
are described in the Non-numerical Errors section of the 
list.  

Entries are arranged alphabetically unless the most 
common cause of a particular error is noted first. 

The instructions assume that the EDconnect 6.X program 
files have been installed to the default C:\Program 
Files\EDconnect6 folder. The program files will typically 
be located on the local hard drive even if the EDconnect 
6.X database is on a network drive. If EDconnect 6.X has 
been installed to a different folder, adjust the instructions 
accordingly. 
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Before Calling CPS/SAIG 
Technical Support 
Before calling CPS/SAIG Technical Support (800/330-5947) for 
assistance with transmission problems, make sure that you are able 
to access the Internet. EDconnect 6.X uses your existing Internet 
connection. If you are unable to view Web pages in your Web 
browser, EDconnect 6.X will not be able to connect to the Student 
Aid Internet Gateway (SAIG). 

You may also want to try one or more of the following to resolve 
transmission problems: 

• Exit EDconnect 6.X, log back in, and try another transmission. 

• Restart your computer and try another transmission. If you 
connect to the Internet though a Local Area Network (LAN), 
restarting your computer may establish a better connection. 

• If you connect to the Internet through a modem and an Internet 
Service Provider (ISP), disconnect from the Internet and 
connect again. Try another transmission. 

• Wait and try another transmission later. If you have been 
successfully sending and receiving files using EDconnect 6.X, 
many transmission errors (Error –1 and Error 4xx, in 
particular) will resolve themselves. 

Note: After a failed transmission, a Mailbox Query will usually 
report that your “Mailbox is empty.” This does not mean that your 
files have been lost. A successful transmission is required before a 
Mailbox Query will accurately reflect the contents of your SAIG 
mailbox.  

Under normal circumstances, you will not lose any files due to 
transmission failures. The EDconnect 6.X Activity Log can help 
you determine which files you have successfully received. 
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Numerical Errors 

An error code may be preceded by a minus sign, as in 
Error –1. The presence or absence of a minus sign does 
not change the meaning of the numerical codes listed 
below. 

Note: CPS/SAIG Technical Support cannot provide specific 
information for configuring firewalls and proxy servers, although 
we may be able to offer general assistance. 

Error –1 
Error –1 indicates that EDconnect 6.X cannot connect to 
the SAIG. You will receive Error –1, for example, if your 
Internet connection is not responding or if a firewall is 
preventing EDconnect 6.X from accessing the Internet. 

Listed below are some of the possible causes of Error –1. 

 

Problem Solution 
CheckPoint firewall  
asks for a password 
 

CheckPoint firewalls can be configured to request  
passwords from users before allowing outbound Internet  
transmissions. EDconnect 6.X may generate Error –1  
if CheckPoint prompts you for a password. Your technical  
support staff may need to remove the password requirement  
for EDconnect 6.X. 
 

Dial-up ISP is not  
currently connected  
to the Internet 
 

If you connect to the Internet through a modem and an ISP,  
you will need to connect to the Internet before transmitting  
with EDconnect 6.X. Make sure you have selected “Direct  
Connection” from the Connection to use drop-down box in  
EDconnect 6.X by clicking on the Tools menu and selecting  
Customize . 
 

Inadequate  
permissions  
or settings 
 

You may not have the necessary permissions or access  
rights on your workstation or network to transmit with  
EDconnect 6.X. Check with your technical support staff.  
Have one of your network technicians log into your  
workstation as an administrator and try a transmission. If  
the transmission is successful, the technician will need to  
change your permissions or access rights. 
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Error –1 (Continued) 

Problem Solution 
Internet connection is  
not working 
 

Make sure you are able to view Web pages in your Web  
browser. If you are unable to access the Internet,  
EDconnect 6.X will not be able to connect to the SAIG. 
 

Local Area Network  
(LAN) connection is  
not plugged in 
 

Make sure the LAN cable is connected to your workstation.  
If it is not plugged in, plug the cable back into the network  
card in your workstation. 
 

Microsoft Winsock  
Proxy Client (WSP  
Client) is not enabled 
 

If your workstation has WSP Client, WSP Client needs to be  
enabled for EDconnect 6.X to connect to the SAIG. 
 

Network interface  
card (NIC) driver may  
be corrupt 
 

Try uninstalling and reinstalling the NIC driver. If you have  
multiple instances of the same NIC driver on your  
workstation, delete the extra instances of the driver, reboot,  
and try transmitting again. 
 

NIC card may be  
“mapped” to a  
specific physical  
location 
 

CPS/SAIG Technical Support talked with a customer who  
had moved her workstation to another location and received  
Error –1 when she tried to transmit. When she moved her 
workstation back to its previous location, she no longer  
received the error. Her technician determined that the NIC  
card in her computer was “mapped” to the network  
connection in her original location. 
 

Packateer software is  
running 
 

See Error 4xx. 
 

Port 26581 is closed  
by a firewall 
 

Port 26581 must be open for outbound TCP/IP  
transmissions and enabled for FTP sessions, and you will  
need to be able to connect to IP address 198.77.163.220.  
If you have never successfully transmitted with  
EDconnect 6.X, contact your network administrators to  
see if you are behind a firewall. 
 

Proxy client not  
installed 
 

Error –1 may occur if a proxy server is running on the  
network but there are no proxy clients on the workstations  
using EDconnect 6.X. Installing the proxy client on any  
workstation that uses EDconnect 6.X may allow  
transmissions to go through. 
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Error –1 (Continued) 

Problem Solution 
Proxy server is not  
configured correctly 
 

If you have a proxy server, port 26581 must be open for  
outbound TCP/IP transmissions and enabled for FTP  
sessions. Your network administrators may need to add  
rules to the proxy filters. Common proxy servers include  
WinProxy, MS Proxy Server, WinGate, and BorderManager  
(Novell). Product vendors may be able to provide specific  
information about proxy setup. 
 

Temporary problem  
with the SAIG 
 

Occasionally, there may be a momentary disruption of the  
SAIG, causing you to receive Error –1. If you normally do  
not have trouble transmitting with EDconnect 6.X, the  
problem will usually resolve itself in a short time. Try another  
transmission later. You may want to wait until after peak  
SAIG network demand, which is between 8:00 a.m. and  
10:00 a.m. Central Time. 
 

Workstation has no 
firewall client 
 

If your network has a firewall, the firewall may require a  
client on workstations that use EDconnect 6.X. You may  
receive Error –1 if the client is not installed. Your technical  
support staff should install the firewall client, if necessary,  
on workstations that use EDconnect 6.X. The firewall vendor  
may be able to provide technical assistance. 
 

Your network uses  
Microsoft Proxy II 
 

The following information was provided by a customer’s  
technician: 

The Microsoft Proxy II client may need to be installed on  
workstations that use EDconnect 6.X. The name of the client 
file is WSPCLNT. It is located in the share folder with the  
proxy server. 
 
The following information was provided by a customer’s  
technician: 

On a network running MS Proxy II/socks 4, the technician  
opened the port for the static IP address for that workstation  
to allow EDconnect 6.X to transmit from that workstation to  
IP address 198.77.163.220. He did not need to add a filter.  
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Error –1 (Continued) 

Problem Solution 
Your network uses  
Novell Border Manager  
(Novell proxy) 
 

The following information was provided by a customer’s  
technician: 

Create an exception that allows the client to contact the  
server from the private interface to the public interface over  
TCP (as opposed to IP or UDP) with a source port of “all”  
and a destination port of 26581. 

Create another exception that allows the server to respond  
to the client from the public interface to the private interface  
over TCP with a source port of “all” and a destination port of  
26581. Allowing “all” or “any” source port is not the best  
security practice. You may need to adjust it down to “high”  
ports on the client side and “privileged” ports on the server  
side. Specifying the server and perhaps even the client host  
addresses would also narrow the exception. 
 

Your network uses  
WinProxy (proxy  
server) 
 

If your network uses WinProxy, you or your technical  
support staff should edit the HOSTIPNAME entries in the  
tdclient.ini file, located by default in the C:\Program  
Files\EDconnect6 folder, to add the proxy server IP address.  
Change the two lines as follows: 

HOSTIPNAME=add proxy server IP address here 
HOSTIPNAME2=198.77.163.220 

If this does not solve the problem, change HOSTIPNAME  
back to 198.77.163.220 and delete the entry for  
HOSTIPNAME2. 
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Special Requirements for Specific Firewalls 

Firewall Requirement 

CheckPoint firewall 
 

Version 4.0 with Service Pack 6 and version 4.1 with  
service pack allow SSL (TLS) negotiation and file  
transfer. Version 4.0 with Service Pack 7 and version  
4.1 with Service Pack 2 or 3 require the application of  
a patch provided by CheckPoint. 
 

Cisco firewall 
 

The following information was provided by a  
customer’s technician: 

FTP is a “jump port.” It jumps between FTP port 21  
and FTP port 20. With a Cisco firewall, you need to  
modify or add to the fix-up table, where it lists the  
common "jump port" protocols, and tell it that FTP  
[for EDconnect 6.X] is using a port other than the  
norm—in this case port 26581. 
 

Gauntlet firewall, Alta Vista  
firewall, and Netscape  
Proxy 
 

These firewalls require socks 5. NEC’s eBorder Client  
is a socks 5 client available for downloading from the  
NEC Web site at nominal cost. Other socks clients are  
available from other vendors. 
 

Raptor firewall 

 

Raptor firewall earlier than 6.5 will not accept the  
AUTH command. Upgrading to version 6.5 will solve  
the problem. 
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Error 2 
Error 2 occurs when EDconnect 6.X cannot establish an FTP session. See Error 
–1 for possible solutions. 

Error 3xx 
Problem Solution 
This is a data path 
issue. The Data or 
temp folders are  
missing or are read-
only 
 

The Data and temp folders are created during  
installation in the folder in which the EDconnect 6.X  
program files are installed. The default location is  
the C:\Program Files\EDconnect6 folder for both  
stand-alone and workstation installations. 

If you receive Error 3xx, one or both of the folders  
may be missing. If you do not have a C:\Program  
Files\EDconnect6\Data folder and a C:\Program  
Files\EDconnect6\temp folder, create them or have  
your technical support staff create them for you. 

If the Data and temp folders exist, check the  
properties of the folders by right-clicking on each  
folder and selecting Properties from the pop-up  
menu. If the folder attributes have been set to  
“Read-only,” remove the read-only attributes and  
try another transmission. 
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Error 4xx 
Error 4xx (the “xx” can denote any number combination) is the result of a slow 
network connection, which may be due to problems on your network or unusually 
high network traffic. If you have been transmitting successfully with EDconnect 
6.X, Error 4xx is usually a temporary problem that will resolve itself. Waiting 
and trying another transmission later will frequently solve the problem without 
any further action on your part. 

See the table on the next page. 
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Error 4xx 

Problem Solution 

General connectivity  
problems  
 

• Your network may be running slowly or dropping its 
connection to the Internet. Check with your technical 
support staff to see if there are problems with your 
network connection. 

• Unusually heavy traffic on your local network may cause 
Error 4xx. If you only experience Error 4xx at certain 
times of day, check with your network administrators to 
see if those times coincide with peak network demand. 

• Unusually heavy traffic on the SAIG may cause Error 
4xx. Try another transmission later. Peak SAIG usage is 
often between 8:00 a.m. and 10:00 a.m. Central Time. 

• If you access the Internet through a LAN, rebooting your 
computer may help resolve Error 4xx. Restarting your 
computer will establish a new connection to your 
network. 

• If you use a dial-up ISP, disconnecting from the Internet 
and connecting again may create a faster or more stable 
connection. 

You may have too  
many programs  
running 
 

See if closing some programs will stop the error or increase  
transmission speed. 
 

Your network uses  
Packateer or other  
software to set  
priorities for Internet  
connections or to limit  
Internet access 
 

Packateer is a program that sets priorities for Internet  
traffic. If the priority for EDconnect 6.X is set too low,  
EDconnect 6.X may “time out” with either Error –1  
or Error 4xx. 

Other programs that may affect transmissions include  
NetEnforcer, ESafe, and many software firewalls. Any  
program that filters Internet packets or scans files during  
transmission may interfere with EDconnect 6.X. Check with  
your network administrators. They may want to disable  
these types of programs temporarily to see if the programs  
are causing the problem. 
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Error 5xx 
Problem Solution 

Error 531 
Your network password 
has expired 
 

If you receive Error 531, you will need to transmit a  
new SAIG password. This error code appears in  
the Activity Log or the More window of the  
Transmission screen. Following the failed transmission,  
EDconnect asks if you would like to complete a  
SAIG password change. If you select Yes, the  
program will take you to the appropriate network  
wizard security screen and walk you through the  
password change. You will need to perform another  
transmission in order to transmit the new password  
change. 

Please note that performing a Network and Local  
SAIG password change does not change your user  
password. “Local,” in this context, refers to the fact  
that EDconnect 6.X stores the SAIG password locally  
(i.e., within the database). 
 

Error 533 
Your network password is 
incorrect  

You may need to call CPS/SAIG Technical Support to  
have your SAIG password reset. In order to reset  
your password, CPS/SAIG Technical Support will ask  
you to provide the Social Security number, date of  
birth, and/or mother’s maiden name of the Destination  
Point Administrator. 
 

Error 540 
Your network password is 
incorrect 
 

You may need to call CPS/SAIG Technical Support to  
have your SAIG password reset. In order to reset  
your password, CPS/SAIG Technical Support will ask  
you to provide the Social Security number, date of  
birth, and/or mother’s maiden name of the Destination  
Point Administrator. 
 

There is a zero-byte file  
in your mailbox (rare) 
 

A zero-byte (empty) file can generate Error 5xx. If  
you have no reason to think your password is incorrect,  
contact CPS/SAIG Technical Support for further  
assistance. 
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Error 10 
Problem Solution 

“No networks defined” in  
the tdclient.ini file 

 

Error 10 usually indicates that EDconnect 6.X was not  
installed correctly. Back up the database  
(EDconn6.mdb) and uninstall EDconnect 6.X. Perform  
a full installation. Replace the blank EDconn6.mdb with  
the database you backed up. Please call CPS/SAIG  
Technical Support for assistance if necessary. 
 

 

Error 13 
Problem Solution 

“Password must match” 

 

You may receive Error 13 if EDconnect 6.X has  
performed an illegal operation and shut down during a  
previous transmission. Under most circumstances, you  
can eliminate the error by resetting your network  
password using the TDCommunityManager (TDCM)  
and performing a Local Only SAIG password change  
in EDconnect 6.X. 

For instructions on using the TDCM, see the  
TDCommunityManager (TDCM) User’s Guide ,  
available at FSAdownload.ed.gov. Instructions for  
changing the SAIG password are included in the  
EDconnect 6.X Help file. To locate the information,  
choose Help Topics from the Help menu and click on  
the Index tab. Type in “SAIG password” (without the  
quotation marks) and select Changing, located directly  
below SAIG password, from the index. 
 

The “list.fil” file is in use 
by another program. 

During testing, SAIG encountered this error when the  
“list.fil” file was open in another program during a  
transmission. 
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Error 15 
Problem Solution 

Incorrect startup folder in  
Windows’ “memory” 

 

Windows “remembers” which folder each program last  
accessed. Error 15 may occur if the current folder in  
Windows’ “memory” is something other than  
C:\Program Files\EDconnect6. The error does not  
occur on all systems and may depend on the type of  
network or workstation configuration. 

Select Open from the EDconnect 6.X File menu and  
make sure the “Look in” folder is set to “EDconnect6.”  
If it is something other than “EDconnect6,” browse to  
the C:\Program Files\EDconnect6 folder, close the  
Open dialog, and try another transmission. 
 

Invalid shortcut 

 

Create a new Desktop shortcut by clicking with the right  
mouse button on the Desktop and choosing New and  
Shortcut from the pop-up menu. Browse to the default  
installation folder C:\Program Files\EDconnect6 and  
select EDconn6.exe. Click Open. Click Next. Type a  
name for the shortcut and click Finish. 
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Error 15 (Continued) 

Problem Solution 

Shortcut “Start in”  
properties are incorrect 

 

If you have created a Desktop shortcut, check the  
shortcut “Start in” properties by right-clicking on the  
icon and selecting Properties from the pop-up menu.  
Click on the Shortcut tab. “Start in” should be set to  
C:\Program Files\EDconnect6, or the folder in which  
EDconn6.exe has been installed. 
 

You are starting  
EDconnect 6.X with  
another program 
 

If you use another program to start EDconnect 6.X, the  
executable file of the program (the .exe file) must be  
located in the same folder as the EDconn6.exe file, or  
must be configured so that the startup folder for  
EDconnect 6.X is the EDconnect folder. 
 

You are switching back  
and forth between  
EDconnect 6.X and  
another program 
 

If you switch to another program while EDconnect 6.X  
is open, then return to EDconnect 6.X, you may receive  
Error 15 when you try to transmit. Exit EDconnect 6.X,  
log back in, and try another transmission. 
 

You are using  
Icebreaker firewall 
 

Icebreaker firewall can prevent EDconnect 6.X from  
transmitting. Disabling the firewall may allow a  
successful transmission. It may be possible to configure  
Icebreaker to work with EDconnect 6.X. Check with  
your technical support staff. 
 

You have changed the  
database path or the Send  
and Receive paths  
 

If you have changed the database path or the Send or  
Receive paths and try to transmit without first exiting  
EDconnect 6.X and logging back in, the transmission  
may fail with Error 15. Exit the program and log back  
in before attempting another transmission. 
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Error 15 (Continued) 

Problem Solution 

You have just created a  
new User ID 
 

When you add a new user to EDconnect 6.X, under  
certain circumstances you may receive Error 15 the  
first time you try to transmit after creating the User ID. 

• If you create a new User ID and customize the Send 
and Receive paths for the user, you may receive Error 
15 if you do not exit EDconnect 6.X and log back in 
before transmitting under any User ID. 

• By default, the EDconnect 6.X Send and Receive 
paths are set to C:\Iam\Data. If you have not 
customized these paths on the Directories tab of the 
User Properties dialog, the text box that displays the 
paths (to the left of the Browse button) will be blank 
for Send and Receive 

EDconnect 6.X allows you to customize the Send and 
Receive paths for individual users, or to “Set all users 
of the group to the specified directories.” If other users 
in a Security Group have customized paths and you 
add a new user, you may receive Error 15 if you do 
not also customize the Send and Receive paths for the 
new user. If you add a new user to a Security Group 
for which you have customized the Send and Receive 
paths for other users, customizing the paths for the 
new user may resolve Error 15. 

 
 
Other Possible Resolutions 

If you are using an earlier version of EDconnect, try upgrading to the latest 
version. Keep in mind that if you have a network installation of EDconnect, the 
server upgrade must be run once, then each workstation will need to be upgraded. 

If your Send and Receive paths point to a network drive, set the paths to the 
default C:\Iam\Data folder. Exit EDconnect 6.X and log back in. Perform a 
“blank transmission” (a transmission with nothing in the Transmission Queue ). 
If you do not get Error 15, set the Send and Receive paths back to your network 
drive, exit EDconnect 6.X, and log back in. Perform another transmission. 
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Error 31 
You will receive Error 31 if there is not sufficient free space on the drive on 
which the Send and Receive folders are located. Make sure the drive has enough 
free space. 

Error 32 
See Error 31. 

Error 48 
If you receive Error 48, check with your technical support staff to see how you 
connect to the Internet. If you use a “virtual modem,” it may be configured 
incorrectly. Your technical support staff will need to resolve the issue. CPS/SAIG 
does not support virtual modems. 

Error 70 
EDconnect 6.X may be trying to access a file or folder on a network drive that 
another user is also trying to access. Restart your computer and try the 
transmission again. 
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Error 103 
Restart your computer and try another transmission. If you continue to get Error 
103, back up your EDconnect 6.X database (EDconn6.mdb) and uninstall and 
reinstall EDconnect 6.X. Restore your original database. Please contact 
CPS/SAIG Technical Support if you need assistance. 

Error 107 
Problem Solution 

An FTP session cannot be  
initiated 
 

This error occurs when an FTP session cannot be  
initiated by EDconnect 6.X. See Error –1 for  
possible causes of this error. 
 

Some of the EDconnect 6.X  
program files or folders are  
read-only 
 

Files that have been saved to CD have the read- 
only attribute set by default. If you have restored  
any EDconnect 6.X files from a CD backup, make  
sure you remove the read-only attribute from all  
restored files. 
 

 

Error 118 
Error 118 is similar to Error 4xx, but seems to occur more often when a dial-up 
ISP is used to connect to the Internet. See Error 4xx for possible resolutions. 

Error 203 
EDconnect 6.X may be attempting to access a file or a folder on a network drive 
that is in use by another user or program. Restart your computer and try another 
transmission. 
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Error 50000 
Warning—A task completed with warnings (warning text is included in response 
log). 

Error 90010 
FTP Connect Error. 

Error 90020 
FTP Login Error—Incorrect Password. 

Error 90030 
FTP Put Error. 

Error 90040 
FTP Audit Error. 

Error 90050 
FTP List Error. 

Error 90060 
FTP Get Error. 

Error 90070 
Decompression Error. 
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Non-numerical Errors 

Problem Solution 

“Access denied because the  
username and/or password is  
invalid on the domain” 
 

You may have selected “T4WAN-X” or “SAIG-X”  
as the Connection to use. Select Customize  
from the Tools menu. Under most circumstances,  
you will want to choose “Direct Connection.” If you  
connect to the Internet through a dial-up ISP, you  
will need to establish a connection before using  
EDconnect 6.X. 
 

“DUN 1.2 not installed”  
(Windows 95) 
 

Dial-up Networking (DUN) must be installed on any  
computer that uses a modem to connect to the  
Internet. If you do not have DUN, download and  
install MSDUN 1.3 from the Microsoft Web site. 
 

“EDconnect must shut down”  
when opening EDconnect 6.X  
(Windows XP) 
 

Right-click on the Desktop shortcut for EDconnect  
6.X and select Properties from the pop-up menu.  
The Convert box must not be checked on the  
Compatibility tab. 
 

“Failed to create an empty  
document” when starting  
EDconnect 6.X or during  
transmission 
 

Two EDconnect 6.X files need to be in the same  
folder as the EDconnect 6.X database: T4api.exe  
and t4api.ini. During a local installation  
of EDconnect 6.X, the files are installed by default  
into the C:\Program Files\EDconnect6 folder.  

During a network installation, the files are installed  
into the network folder containing the database. If  
your EDconnect 6.X database is on a network,  
check to see if the T4api.exe and t4api.ini are in  
the network folder containing the database. If the  
files are not in the network folder, move the files 
from your local drive to the network folder. If  
the files are on both your local drive and in the 
network folder containing the database, delete  
the files from your local drive. 
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Non-Numerical Errors (Continued) 
Problem Solution 

“Incompatible version” error  
message when using  
Transmission Queue  
templates 
 

When opening Transmission Queue templates,  
such as all.tqt, you may be selecting templates from  
the folder of a previous version of EDconnect. Be  
sure you are selecting templates from C:\Program  
Files\EDconnect6 rather than C:\Program  
Files\EDconnect. 

If you have created Desktop shortcuts to templates,  
check to see if the shortcuts point to templates in  
the C:\Program Files\EDconnect6 folder. You can  
check shortcut properties by right-clicking on the  
shortcut icon and choosing Properties from the  
pop-up menu. Go to the Shortcut tab and check  
the Target path. 
 

“Invalid page fault in module  
Ssockapi.dll” 
 

If you receive this error, you will need to uninstall  
and reinstall EDconnect 6.X. Back up your  
EDconnect 6.X database first (EDconn6.mdb).  
After you reinstall EDconnect 6.X, restore the  
backed-up database and try another transmission.  
If you still receive the error, contact CPS/SAIG  
Technical Support for further assistance. 
 

“Invalid sender for message  
class” error referencing  
CONNCT32 files 
 

EDconnect 6.X sends a CONNCT32 file each time  
you transmit. Under normal circumstances, the file  
is automatically deleted from your mailbox. If the  
file is not deleted promptly, EDconnect 6.X will try  
to download it, generating the error. You may see  
the error if you have tried several transmissions  
over a short period of time. Clicking the OK button  
on the error message dialog (this sometimes requires  
several clicks) will usually allow you to download  
your files. The next time you use EDconnect 6.X,  
you should not receive the error. 
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Non-Numerical Errors (Continued) 
Problem Solution 

“Invalid sender for message  
class” error referencing  
PGDR02IN files 
 

You will receive this error if you have included the  
transmission header O*N05 and the transmission  
trailer O*N95 in the files you are sending with  
EDconnect 6.X. Files cannot contain transmission  
headers and trailers. If you are using Datatel  
software to process Pell, Datatel has a patch  
available. If you are processing files using a  
mainframe, you must create the files without the  
O*N05 or the O*N95. Any files that contained  
headers and trailers prior to transmission will have  
to be sent again without the headers and trailers. 
 

“Path does not exist” during  
transmission 
 

This error refers to the Send or Receive paths  
that have been set up in EDconnect 6.X, such as  
C:\Iam\Data. 

If you receive this error, first check to make sure the  
paths are valid. This is particularly important if your  
Send and Receive paths are on a network drive.  
Your workstation may have temporarily lost its  
connection to the drive. 

If the paths exist, you will need to check the folder  
properties to see if the folder attributes have been  
set to read-only. Right-click on each folder in the  
path (such as C:\Iam) and select Properties from  
the pop-up menu. Check the folder Attributes. If  
the folder is read-only, uncheck the read-only box  
and click OK. Right-click on the folder again to  
make sure the change has “stuck.” If you find any  
read-only folders in the EDconnect 6.X Send or  
Receive paths and cannot remove the read-only  
attributes, contact your technical support staff.  
They may need to use the “attrib” command to  
remove the read-only property from folders that  
are “stuck” by opening a command prompt and  
using the command “attrib -r c:\folder name”. The  
command must be used on each read-only folder  
in the Send and Receive paths. 
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Non-Numerical Errors (Continued) 
Problem Solution 

“RAS Services from Service  
Pack 3 required to transmit”  
(Windows NT) 
 

Remote Access Service (RAS) must be installed  
if you connect to the Internet using a modem. This  
error usually indicates that RAS has not been  
installed on your computer, or that RAS has been  
installed but the latest service pack has not  
been reinstalled. 

Have your technical support staff check to see if  
RAS has been installed. If you do not have RAS,  
they will need to install it, then reinstall the latest  
service pack. If you already have RAS, they will  
need to install Service Pack 3 or higher. 
 

“System error: error  
encountered during shell  
execute” (Windows 2000) 
 

If you receive this error when starting EDconnect  
6.X, clicking OK will usually allow you to continue  
normally. To fix the problem, select New from the  
File menu and Security View from the list of views.  
Right-click on your User ID and choose Properties  
from the pop-up menu. On the General tab, uncheck  
the “Show splash screen on startup” checkbox and  
click OK. Exit EDconnect 6.X and start it again.  
You should no longer see the error message. 
 

“System error: unable to  
remove headers and trailers”  
(Windows 2000) 
 

You may receive this error if you are not a “Power  
User” or “Administrator” of your Windows 2000  
workstation, or if you do not have permission to  
download files to certain network folders (in  
particular, the Receive folder specified in EDconnect  
6.X). Have one of your technical support staff log on  
as an administrator and try a transmission. If this  
works, your technical support staff will have to  
change your permission levels. 
 

“System error: unidentified  
RAS error: [number]”  
(Windows NT) 
 

You may have selected “T4WAN-X” or “SAIG-X”  
as the Connection to use. Select Customize from  
the Tools menu. Under most circumstances, you will  
want to select “Direct Connection.” 
 

“Unable to create empty file” 
 

Restart your computer and try another transmission. 
 

 


